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Ներածություն 

 

Քարտեզները մարդկային հասարակության կողմից օգ-

տագործվում են արդեն հազարամյակներ, սակայն ընդամենը 

40 տարի է, ինչ գրաֆիկական և նկարագրական տեղեկատ-

վությունը միավորվել է՝ առաջին աշխարհագրական տեղե-

կատվական համակարգերի (ԱՏՀ) ստեղծման նպատակով: 

Այդ մոտեցումը (գրաֆիկական և նկարագրական ինֆորմա-

ցիայի միավորումը) ԱՏՀ ամենակարևոր և հիմնարար 

սկզբունքներից մեկն  է: 

Սույն ուղեցույցում ներկայացված է գործնական պարապ-

մունքների ընթացքում դիտարկված ԱՏՀ գործառույթների ամ-

փոփ նկարագիրը: Ուղեցույցը կօգնի ինչպես դասընթացներին 

մասնակցած, այնպես էլ չմասնակցած ուսանողներին օգտվել 

ArcGIS 10 ծրագրային փաթեթի հնարավորություններից իրենց 

աշխատանքային խնդիրները լուծելիս: 

ArcGIS ծրագրերի հավաքածուն մշակվել է Շրջակա միջա-

վայրի համակարգերի ուսումնասիրությունների ինստիտուտի 

(Environmental Systems Research Institute, ESRI) կողմից և ընդ-

գրկում է սեղանային համակարգիչների, սերվերների, դյուրա-

կիր սարքերի համար նախատեսված և օնլայն ԱՏՀ ծրագրեր: 

Սույն ուղեցույցը ներառում է ArcGIS Desktop ծրագրային փա-

թեթը (ArcInfo ֆունկցիոնալությամբ), որը նախատեսված է 

համակարգիչների համար, ինչպես նաև դրա Spatial Analyst և 

3D Analyst ընդլայնումները: 
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1. Աշխատանքի սկիզբ «ArcGIS»-ում 

 

1.1 ArcMap միջավայր 

 

ArcMap-ը ArcGIS ծրագրային փաթեթի առանցքային մասն 

է, որտեղ հասանելի են ArcGIS-ի գործառույթների մեծամաս-

նությունը: Այստեղ հնարավոր է ավելացնել և խմբագրել 

տվյալները, կազմել հարցումներ, դասակարգել քարտեզի շեր-

տերը, աշխատել դրանց գունային սխեմաներով, իրակա-

նացնել վեկտորային և ռաստրային տվյալների վերլուծություն, 

կազմել քարտեզներ և արտահանել նկարների տեսքով: 

ArcMap-ը կարելի է գործարկել Start  մենյուից մուտք գոր-

ծելով  All Programs, այնուհետև ArcGIS թղթապանակ և ընտրել 

ArcMap 10: Կարելի է նաև ստեղծել հղում (shortcut) և տեղա-

դրել աշխատանքային սեղանին (desktop): 

 

1.2 Տվյալների ավելացում ArcMap-ում 

 
ArcMap-ում տվյալներ ավելացնելու համար File մենյուից 

անհրաժեշտ է մուտք գործել Add data ենթամենյու կամ մկնի-

կով սեղմել Add data կոճակի վրա (), որը գտնվում է ստան-

դարտ գործիքների պանելում: Այնուհետև պետք է տեղափոխ-

վել թղթապանակ, որտեղ գտնվում են ԱՏՀ տվյալները: 
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Նկ. 1. Տվյալների ավելացում (Add Data) 

 

ArcGIS 10-ում կարելի է օգտագործել Add Data կոճակը 

նաև այլ առցանց աղբյուրներից տվյալներ ավելացնելու հա-

մար՝ Add Basemap և Add Data From ArcGIS Online հնարավո-

րությունների միջոցով: Add Basemap-ի միջոցով որպես հիմքա-

յին քարտեզներ կարելի է ավելացնել, օրինակ, Bing արբանյա-

կային պատկերներ, OpenStreetMap տվյալներ, տոպոգրաֆիա-

կան քարտեզներ և այլն: ArcGIS Online-ի միջոցով կարելի է 

ներմուծել տարատեսակ տվյալների շերտեր: Add Data կո-

ճակը սեղմելուց հետո պետք է տեղափոխվել թղթապանակ և 

ընտրել հետաքրքրող շերտը (շերտերը): 

ArcMap նախագիծը պահպանելու համար պետք է սեղմել 

 կոճակը գործիքների հիմնական պանելից կամ Save կո-

ճակը՝ File մենյուից (նկ. 2): 
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Նկ. 2. ArcMap նախագծի պահպանում 

 

Save կոճակը սեղմելուց հետո կբացվի պատուհան, որտեղ 

պետք է ցույց տալ, թե որ թղթապանակում պետք է պահվի 

նախագիծը և ինչ անվան տակ (նկ. 3): ArcMap նախագծերի 

ֆայլային ընդլայնումը «.mxd» է: 

 

 
Նկ. 3. ArcMap նախագծի պահպանում «Protected_Areas.mxd»  

անունով 
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1.3 ArcCatalog-ը որպես ԱՏՀ տվյալների կառավարման 

միջավայր 

 

ArcCatalog հավելվածն օգտագործվում է աշխարհագրա-

կան տեղեկատվական համակարգերում ինֆորմացիայի կազ-

մակերպման և կառավարման համար: ԱՏՀ տվյալները կարող 

են պահվել թղթապանակներում՝ առանձին շեյփֆայլերի և 

ռաստրային նկարների տեսքով, ինչպես նաև պահպանվել 

տարածական տվյալների հենքերում (geodatabase): 

Գեոտվյալների բազաներն աշխարհագրական տարբեր 

տիպի տվյալների հավաքածուներ են, որոնք օգտագործվում 

են ArcGIS-ում: Գոյություն ունեն մի քանի տիպի գեոտվյալ-

ների բազաներ. 

 Գեոտվյալների ֆայլային բազա (*.gdb ընդլայնում) – 

դիսկի վրա գտնվող ֆայլերով թղթապանակ 

 Գեոտվյալների անհատական բազա – Microsoft 

Access տվյալների բազայի ֆայլ (.mdb) 

 Տվյալների բազաների կառավարման համակարգեր 

(Oracle, SQL Server, Informix, DB2, PostgreSQL) 

ArcCatalog-ը ներկայացնում է այդ տվյալները կատալոգի 

ծառային կառուցվածքի տեսքով, ինչով հեշտացնում է դրանց 

հետ աշխատանքը: 

ArcCatalog-ը նավիգացիայի և աշխարհագրական տեղե-

կատվության տարրերի հետ աշխատանքի համար օգտագոր-

ծում է երկու հիմնական պանել (նկ. 4): 
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Նկ. 4. ArcCatalog հավելվածի հիմնական տարրերը 

 

ArcCatalog-ում հնարավոր է ստեղծել նոր տարածական 

ֆայլեր, տեղափոխել, անվանափոխել և կատարել այլ գործո-

ղություններ դրանց հետ: 

 

1.4 Նոր շեյփֆայլի ստեղծում 

 

Դիտարկենք նոր շեյփֆայլի ստեղծման գործընթացը: 

Ենթադրենք, սքանավորված քարտեզից մեզ պետք է թվայ-

նացնել հատուկ պահպանվող տարածքները: Քանի որ այդ 

տարածքները մակերեսներ են, մեզ անհրաժեշտ է ստեղծել 

պոլիգոնալ վեկտորային շերտ: 

ArcCatalog-ի կատալոգի ծառից անհրաժեշտ է ընտրել այն 

թղթապանակը, որտեղ պետք է պահել շեյփֆայլը: Այնուհետև, 

աջ պատուհանում (բովանդակության բաժնում) պետք է աջ 

քլիք անել ազատ տարածքում, բացված մենյուից ընտրել New, 

այնուհետև՝ Shapefile (նկ. 5): 

 

Միանալ ֆայլյին թղթապանակների 

Շերտի 

նկարագրություն 

Բովանդակություն 

Շերտի 

նախադիտում 

Բարձրանալ մեկ մակարդակ վերև 

Բովանդակության 

պատուհան Տվյալների 

բազայի, շերտերի 

խմբի կամ շերտի 

անվան վրա աջ 

կոճակը սեղմելով 

կբացվի մենյուն 

Կատա-

լոգի 

ծառի 

պանել 
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Նկ. 5. Նոր շեյփֆայլի ստեղծում ArcCatalog-ում 

 

Բացված պատուհանում անհրաժեշտ է մուտքագրել շեյփ-

ֆայլի անունը Name բաժնում, ինչպես նաև ընտրել դրա 

երկրաչափական ձևը՝ կետային, գծային կամ մակերեսային 

(պոլիգոնալ) (նկ. 6): 

 

 
Նկ. 6. Հատուկ պահպանվող տարածքների պոլիգոնալ շերտի 

ստեղծում ArcCatalog- ում 
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Այլ տարածական ինֆորմացիայի հետ ինտեգրելու հա-

մար ստեղծվող նոր շեյփֆայլին անհրաժեշտ է կցել կոորդի-

նատային համակարգ: Դրա համար պետք է Create New 

Shapefile պատուհանում սեղմել Edit կոճակը, որից հետո 

կբացվի պատուհան, որտեղ անհրաժեշտ է ընտրել կոոր-

դինատային համակարգը (նկ. 7): 

 

 

Նկ. 7. Նոր ստեղծվող շեյփֆայլին կոորդինատային համակարգի 

կցում 

 

Կոորդինատային համակարգը պետք է ընտրել՝ ելնելով 

ստեղծվող ֆայլի նախատեսվող տարածական ընդգրկումից, 

օգտագործման նպատակներից և առկա տարածական տվյալ-

ների կոորդինատային համակարգից: Կոորդինատային հա-

մակարգերը բաժանվում են երկու խմբի՝ աշխարհագրական և 

պրոյեկտված: Այս օրինակում ընտրված է WGS 1984 կոոր-

դինատային համակարգի UTM պրոյեկցիան, վերջինիս  38N 

զոնան, որն ընդգրկում է Հայաստանի տարածքը: Պրոյեկտա-

վորված կոորդինատային համակարգերը թույլ են տալիս իրա-
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կանացնել ավելի շատ չափողական և վերլուծական գործողու-

թյուններ տարածական ֆայլերի հետ, քան աշխարհագրական 

կոորդինատային համակարգերը: 

Կոորդինատային համակարգ ընտրելուց հետո պետք է 

սեղմել OK կոճակը, և շերտը կհայտնվի թղթապանակում: 

 

  
                                    (ա) (բ) 

Նկ. 8. Հատուկ պահպանվող տարածքների շեյփֆայլի տեսքը 

ArcCatalog-ում (ա) և Windows Explorer-ում (բ) 

 

1.5 Տվյալների խմբագրում 
 

Նախորդ կետում ստեղծված հատուկ պահպանվող տա-

րածքների պոլիգոնալ ֆայլը ավելացնենք ArcMap՝ մեր կողմից 

ստեղծված Protected_Areas.mxd նախագիծ (նկ. 7)։ 
 

 

Նկ. 7. Հատուկ պահպանվող տարածքների շեյփֆայլի ավելացում 

ArcMap-ում 
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Add կոճակը սեղմելուց հետո շերտը կհայտնվի ArcMap-ի 

ձախ՝ շերտերի պատուհանում (Layers) (նկ. 8): 
 

 

Նկ. 8. Հատուկ պահպանվող տարածքների շեյփֆայլի ավելացում 

ArcMap-ում 

 

Այսպիսով, ավելացրեցինք դատարկ շերտ: Դրա մեջ տե-

ղեկատվություն ավելացնելու համար պետք է ունենալ հիմ-

քային ինֆորմացիա: Այդ նպատակով, օրինակ, ավելացնենք 

ՀՀ հատուկ պահպանվող տարածքների քարտեզը՝ նկարի 

տեսքով (նկ. 9): 
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Նկ. 9. ՀՀ բնության հատուկ պահպանվող տարածքների քարտեզ, 

ավելացված ArcMap նախագծում 

 

Այսպիսով, ArcMap նախագծում ունենք բնության հատուկ 

պահպանվող տարածքների (այսուհետ՝ ԲՀՊՏ) քարտեզ` նկա-

րի ֆորմատով, և դատարկ պոլիգոնալ շեյփֆայլ: Մկնիկի աջ 

սեղմումով շեյփֆայլի անվան վրա բացենք ատրիբուտային 

աղյուսակը (նկ. 10): 
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Նկ. 10. Protected Areas շերտի ատրիբուտային աղյուսակը 

 

Բացված ատրիբուտային աղյուսակում տեսնում ենք, որ 

բացի ID-ից չունենք այլ դաշտեր, որտեղ կարելի է լրացնել 

թվայնացվող օբյեկտների վերաբերյալ նկարագրական տեղե-

կությունը: Այդ պատճառով անհրաժեշտ է ավելացնել նոր 

դաշտեր, որոնք կբնութագրեն ԲՀՊՏ-երը: 

Ատրիբուտային աղյուսակի վերին ձախ անկյունում սեղ-

մելով Table Options կոճակը՝ կբացվի մենյու, որտեղից պետք է 

ընտրել Add Field... հնարավորությունը (նկ. 11): 

 

 
Նկ. 11. Ատրիբուտային աղյուսակում նոր դաշտի ավելացում (Add 

Field) 
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Բացված պատուհանում պետք է լրացնել ավելացվող 

դաշտի անունը և ընտրել դրա տիպը (տեքստային, ամբող-

ջական կամ կոտորակային թվային, ամսաթվային): Անվան 

դաշտում լրացնենք Name, ընտրենք տեքստային (Text) դաշտի 

տիպը, դաշտի երկարությունը (Field Properties - Length) 

թողնենք 50 նիշ (նկ. 12): 

 

 
Նկ. 12. ԲՀՊՏ անվան տեքստային դաշտի ավելացում 

 

Add Field...-ի միջոցով ավելացնենք նաև դաշտեր մակե-

րեսների (Area) և կոորդինատների (X_coord, Y_coord) լրաց-

ման համար: Բոլոր դաշտերը պետք է լինեն կոտորակային 

թվերի ֆորմատի (Double) (նկ. 13): 
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Նկ. 13. ԲՀՊՏ մակերեսի թվային դաշտի ավելացում 

 

Ավելացնենք նաև տեքստային դաշտ ԲՀՊՏ-ի հակիրճ 

նկարագրության համար, դաշտի երկարությունը սահմանենք 

200 նշան, քանի որ այստեղ կարող է լինել բավականին երկար 

տեքստ (նկ. 14): 
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Նկ. 14. ԲՀՊՏ հակիրճ նկարագրության դաշտի ավելացում 

 

Այսպիսով, ատրիբուտային աղյուսակում ավելացրեցինք 

անհրաժեշտ դաշտերը, որոնք լրացնելով կարող ենք բնութա-

գրել ԲՀՊՏ-երը: Այժմ պետք է անցնել բուն թվայնացման պրո-

ցեսին` ստեղծել պոլիգոնալ օբյեկտներ նկարի հիման վրա և 

լրացնել այդ օբյեկտների ատրիբուտները: 

Թվայնացումը սկսելու համար պետք է միացնել խմբա-

գրման գործիքները Editor պանելից: 

Եթե պանելը բացակայում է, այն պետք է ակտիվացնել` 

սեղմելով մկնիկի աջ կոճակը ArcMap-ի գործիքների հատվա-

ծի վրա, այնուհետև ընտրել Editor կոճակը (նկ. 15, 16): 
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Նկ. 15. Editor գործիքների պանելի ավելացում 

 

 
Նկ. 16. Editor գործիքների պանել 

 

Խմբագրման գործընթացը սկսելու համար պետք է Editor 

մենյուից ընտրել Start Editing կոճակը (նկ. 17), այնուհետև 

նույն մենյուից՝ Editing Window => Create Features (նկ. 18): 
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Նկ. 17. Խմբագրման պրոցեսի սկիզբ (Start Editing) 

 

 

Նկ. 18. Օբյեկտների ստեղծման պատուհան (Create Features) 

 

Create Features պատուհանում ընտրել Protected_Areas 

դաշտը և կակտիվանա օբյեկտների թվայնացման գործիքը: 

Մոտեցնենք պատկերը ԲՀՊՏ-ներից մեկի վրա: Դա կա-

րելի է անել Zoom գործիքների միջոցով (նկ. 19): 
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Նկ. 19. Zoom In և Zoom Out գործիքներ 

 

Մոտեցնելուց հետո թվայնացման գործիքով սկսենք արտա-

գծել ԲՀՊՏ-ն՝ դնելով կետեր (նկ. 20): Ամբողջ տարածքն ար-

տագծելուց հետո պետք է երկու անգամ սեղմել մկնիկով 

(double click)՝ օբյեկտի ավելացման պրոցեսն ավարտելու 

համար (նկ. 21): 

 

Նկ. 20. Պոլիգոնալ օբյեկտի թվայնացման պրոցես 
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Նկ. 21. Թվայնացված պոլիգոնալ օբյեկտ 

 

Բացենք ԲՀՊՏ շերտի ատրիբուտային աղյուսակը: Թվայ-

նացված օբյեկտի հետ աղյուսակում ավելացել է տող, որտեղ 

կարող ենք լրացնել այդ օբյեկտը բնութագրող տվյալները (նկ. 

22): 
 

 

Նկ. 22. ԲՀՊՏ շերտի ատրիբուտային աղյուսակը, որտեղ ավելացել է 

թվայնացված օբյեկտին համապատասխանող տող 

 

Տեքստային դաշտերը պետք է լրացնել ձեռքով, իսկ 

օբյեկտների երկրաչափական տվյալները և կոորդինատները 

կարող են հաշվարկվել ծրագրի կողմից: Դրա համար թվային 

դաշտի անվան վրա պետք է մկնիկի աջ կոճակով սեղմել, 

այնուհետև՝ Calculate Geometry (նկ. 23): 
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Նկ. 23. Օբյեկտների երկրաչափական բնութագրիչների հաշվարկ 

(Calculate Geometry) 

 

Բացված պատուհանում Property մենյուից ընտրենք մա-

կերեսը (Area), Units մենյուից՝ չափման միավորը (այս դեպ-

քում՝ քառ. կմ) (նկ. 24): 

 
Նկ. 24. ԲՀՊՏ մակերեսների հաշվարկ 
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OK կոճակը սեղմելուց հետո Area դաշտում կբացվի ԲՀՊՏ 

մակերեսը (նկ. 25): 

 

 

Նկ. 25. ԲՀՊՏ հաշվարկված մակերեսը 

 

Նույն կերպ կարելի է հաշվարկել պոլիգոնալ օբյեկտների 

պարագծերը և երկրաչափական կենտրոնի կոորդինատները: 

Գծային օբյեկտների համար Calculate Geometry-ի միջոցով կա-

րելի է հաշվարկել երկարությունը, սկզբնակետի, վերջնակետի 

և երկրաչափական կենտրոնի XY կոորդինատները, կետերի 

համար՝ միայն կոորդինատները: 

Հաճախ կարող է անհրաժեշտ լինել պոլիգոնալ օբյեկտին 

ավելացնել նույն բովանդակության մեկ այլ հարակից օբյեկտ՝ 

պահպանելով ընդհանուր սահմանը: Նման դեպքերում պետք 

է օգտագործել Auto Complete Polygon գործիքը Construction 

Tools մենյուից (նկ. 26): 
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Նկ. 26. Auto Complete Polygon գործիքով հարակից պոլիգոնի 

թվայնացում 

 

Եթե անհրաժեշտ է միավորել նույն շերտի երկու կամ 

ավելի օբյեկտներ, ապա պետք է օգտագործել Merge գործիքը: 

Այն պետք է ավելացնել ArcMap-ի հիմնական գործիքների պա-

նելին Customize մենյուից: 

 
 

 
Նկ. 27. Merge գործիքի ավելացում 
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Միավորելու համար պետք է նախ ընտրել օբյեկտները: 

Դա կարելի է անել քարտեզի վրայից՝   կամ  գործիքների 

միջոցով, կամ ատրիբուտային աղյուսակից՝ նշելով երկու կամ 

ավել տողերը: Նշելուց հետո պետք է սեղմել Merge կոճակը: 

Կբացվի պատուհան, որտեղ պետք է ընտրել հիմնական օբ-

յեկտը, որին պետք է միանա մյուս օբյեկտ(ներ)ը (նկ. 28): Ատ-

րիբուտային աղյուսակում կպահպանվեն հիմնական օբյեկտի 

կոորդինատները: 

 

 

Նկ. 28. Օբյեկտների միացման (Merge) գործընթացը 

 

Հնարավոր է կատարել նաև հակառակ գործողությունը՝ 

օբյեկտը բաժանել երկու մասի: Այդ նպատակով պետք է օգ-

տագործել Cut Polygon գործիքը Editor գործիքների պանելից 

(նկ. 29): 
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Նկ. 29. Պոլիգոնի բաժանում Cut Polygon գործիքով 

 

Նմանատիպ գործողություն կարելի է կատարել նաև գծա-

յին օբյեկտի նկատմամբ՝ օգտագործելով Split գործիքը Editor 

գործիքների պանելից: 

Խմբագրման պրոցեսն ավարտելուց հետո անհրաժեշտ է 

պահպանել փոփոխությունները՝ Editor մենյուից սեղմելով 

Save Edits կոճակը կամ Stop Editing-ը՝ դիալոգային պատուհա-

նում ընտրելով Yes տարբերակը: 
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2. Կոորդինատային համակարգեր և պրոյեկցիաներ 

 

2.1 Տեղագրական քարտեզների գեոկապակցում 

 

Այս բաժնում կդիտարկենք ԽՍՀՄ տեղագրական քար-

տեզների գեոկապակցման գործընթացը (նկ. 30): 

 

 

Նկ. 30. Տեղագրական քարտեզի օրինակ 

 

Տեղագրական քարտեզները սքանավորված են և պահվում 

են նկարների տեսքով: ԱՏՀ-ում դրանք կիրառելի դարձնելու 

համար (օրինակ՝ դրանցից բարձրությունների հորիզոնական-

ները թվայնացնելու կամ ուղղակի որպես քարտեզի ֆոն օգ-

տագործելու համար) անհրաժեշտ է իրականացնել «Գեոկա-
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պակցում» (Georeferencing) կոչվող գործընթացը՝ կապակցելով 

քարտեզը կոորդինատային համակարգին: 

Գեոկապակցման համար նկարը պետք է ավելացվի 

ArcMap նոր նախագծի մեջ: Սակայն մինչ այդ ArcMap-ի 

տվյալների շրջանակին (Data Frame) պետք է տալ կոորդի-

նատային համակարգ: ԽՍՀՄ ժամանակաշրջանի տեղագրա-

կան քարտեզները կազմվել են՝ օգտագործելով Pulkovo 1942 

դատումը, այդ պատճառով տվյալների շրջանակին կտանք 

Pulkovo 1942 աշխարհագրական կոորդինատային համակար-

գը: Տվյալների շրջանակին կոորդինատային համակարգ տա-

լու համար պետք է մկնիկի աջ կոճակով ընտրել Layers հրա-

մանը, այնուհետև ընտրել Properties => Coordinate Systems => 

Geographic Coordinate Systems => Europe => Pulkovo 1942 (նկ. 

31): 
 

 

Նկ. 31. Կոորդինատային համակարգի կցում տվյալների շրջանակին 
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Այնուհետև նախագծին ավելացնենք տեղագրական քար-

տեզը Add data-ի միջոցով (նկ. 32): 
 

 

Նկ. 32. Տեղագրական քարտեզի ավելացում ArcMap նախագծին 

 

Add կոճակը սեղմելուց հետո կբացվի զգուշացում, որ 

ավելացվող նկարը չունի կոորդինատային համակարգ: 

Տեղագրական քարտեզն ավելացնելուց հետո դրա գեոկա-

պակցման համար անհրաժեշտ է միացնել Georeferensing գոր-

ծիքների պանելը (նկ. 33): 

 

 

Նկ. 33. Georeferencing գործիքների պանելի ավելացում 
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Մոտեցնենք պատկերը տեղագրական քարտեզի վերևի 

ձախ անկյան վրա: Կտեսնենք, որ այնտեղ գրված են աշխար-

հագրական լայնության և երկայնության արժեքները: Վերց-

նենք Add Control Points գործիքը Georeferencing պանելից: Մեկ 

անգամ ձախ, այնուհետև աջ քլիք անենք լայնության և երկայ-

նության գծերի հատման կետում: Բացված մենյուից պետք է 

ընտրել Input DMS of Lon and Lat (մուտքագրել երկայնության և 

լայնության աստիճան, րոպե, վայրկյանները) տարբերակը 

(նկ. 34): 
 

 

Նկ. 34. Ստուգողական կոորդինատային կետի ավելացում 

 

Բացված պատուհանում պետք է լրացնել նշված կետի 

կոորդինատները: Longitude տողում պետք է լրացնել 45 30 00 

(քանի որ վայրկյաններ նշված չեն, լրացնում ենք 00, հակա-

ռակ դեպքում 3-րդ դաշտում պետք է լիներ վայրկյանների ար-

ժեքը) և ընտրել E կոճակը (արևելյան կիսագունդ՝ E, արև-

մտյան՝ W): Latitude տողում պետք է լրացնել 39 40 00 և ընտրել 

N կոճակը (հյուսիսային կիսագունդ՝ N, հարավային՝ S): 

Սեղմենք OK կոճակը (նկ. 35): 
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Նկ. 35. Նշված կետի կոորդինատների լրացում 

 

Նույն գործողությունը պետք է կատարել քարտեզի մնա-

ցած երեք անկյունների համար: Յուրաքանչյուր կետ ավելաց-

նելուց հետո քարտեզը կտեղաշարժվի և կարող է անհետանալ 

տեսադաշտից: Այդ դեպքում պետք է աջ քլիք անել քարտեզի 

անվան վրա Table of Contents պատուհանում և սեղմել Zoom to 

Layer (նկ. 36): 

 

 

Նկ. 36. Zoom to Layer կոճակը 

 

Ավելացված կետերը կարելի է դիտել կամ, անհրաժեշտու-

թյան դեպքում, հեռացնել ցանկացած կետ Link պատուհա-

նում: Պատուհանը բացվում է View Link Table կոճակի միջո-

ցով (նկ. 37): 
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Նկ. 37. Կոորդինատային կետերի դիտման աղյուսակ (Link Table) 

 

Բոլոր անհրաժեշտ կետերն ավելացնելուց հետո պետք է 

պահպանել քարտեզը կոորդինատային համակարգով ռաստ-

րային ֆայլի տեսքով: Այդ նպատակով Georeferencing (վայր 

ընկնող) մենյուից պետք է ընտրել Update Georeferencing կամ 

Rectify տարբերակները: Առաջինը կոորդինատային համա-

կարգը փոխանցում է անմիջապես բացված ֆայլին, երկրորդը 

ստեղծում է նոր ֆայլ: Ընտրենք Rectify տարբերակը (նկ. 38): 
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Նկ. 38. Քարտեզին կոորդինատային համակարգի հաղորդում 

 

Rectify կոճակը սեղմելուց հետո կբացվի պատուհան, որ-

տեղ պետք է նշել ելքային ֆայլի տեղադիրքը, անունը, ֆոր-

մատը և սեղմել Save կոճակը (նկ. 39): 

 

 
Նկ. 39. Rectify գործողության իրականացման պատուհան 

 

Ստացված ֆայլն արդեն պիտանի կլինի ԱՏՀ-ում օգտա-

գործման համար: 
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2.2 Նկարների գեոկապակցում 

 

Նախորդ բաժնում դիտարկեցինք կոորդինատային ցան-

ցով տեղագրական քարտեզի գեոկապակցման գործընթացը: 

Այժմ կատարենք առանց կոորդինատային ցանցի՝ նկարի գեո-

կապակցում: 

Բացենք նոր ArcMap նախագիծ: Այս անգամ տվյալների 

շրջանակին տանք պրոյեկտավորված UTM կոորդինատային 

համակարգ (Layers => Properties => Coordinate System => 

Projected Coordinate Systems => UTM => WGS 1984 => Northern 

Hemisphere => WGS 1984 UTM Zone 38N): 

Դրանից հետո նախագծին ավելացնենք հետաքրքրող 

նկարը (նկ. 40): 

 

 

Նկ. 40. Առանց կոորդինատային ցանցի ԲՀՊՏ քարտեզ՝ ավելացված 

ArcGIS նախագծում 

 

 



37  

Քանի որ այս քարտեզը չունի կոորդինատային ցանց, մեզ 

պետք է մեկ այլ, կոորդինատային համակարգ ունեցող շերտ, 

որի միջոցով կկապակցենք քարտեզը: Ավելացնենք ՀՀ մարզե-

րի վեկտորային շերտը: Ավելացնելուց հետո այն չի երևա էկ-

րանին, քանի որ նկարի և դրա կոորդինատները չեն համա-

պատասխանում: Աջ քլիք անենք մարզերի անվան վրա Table 

of Contents-ում, այնուհետև՝ Zoom to Layer: Մարզերի շերտը 

կհայտնվի ArcMap աշխատանքային միջավայրի կենտրոնում 

(նկ. 41): 

 

 

Նկ. 41. Մարզերի վեկտորային շերտ 

 

Այժմ անհրաժեշտ է ԲՀՊՏ քարտեզը կապակցել այս շեր-

տին՝ օգտագործելով այն փաստը, որ և՛ մարզերի շերտը, և՛ 

քարտեզը ներկայացնում են ՀՀ սահմանները: 

Georeferencing մենյուից սեղմենք Fit to display կոճակը: 

ԲՀՊՏ քարտեզը կբացվի ArcMap աշխատանքային պատու-

հանի երևացող հատվածում (նկ. 42): 
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Նկ. 42. Կապակցվող քարտեզի տեղափոխում ArcMap պատուհանի 

աշխատանքային հատված Fit to Display կոճակի միջոցով 

 

Թափանցիկացնենք մարզերի շերտը՝ տեսանելի թողնելով 

միայն սահմանները: Դրա համար անհրժեշտ է Table of 

Contents-ում մկնիկի օգնությամբ սեղմել մարզերի պայմանա-

կան նշանի վրա, ընտրել Hollow և մեծացնել սահմանագծի 

հաստությունն ու փոխել գույնը (նկ. 43): 
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Նկ. 43. Մարզերի շերտի պայմանական նշանների փոխում 

 

Այնուհետև Add Control Points գործիքով պետք է կապակ-

ցել ԲՀՊՏ քարտեզի և մարզերի շերտի վրա իրար համապա-

տասխանող կետերը: Նախ պետք է մեկ անգամ մկնիկի ձախ 

կոճակով սեղմել քարտեզի վրա, այնուհետև նույնն անել մար-

զերի շերտի համապատասխան կետի վրա: Առաջին կետը 

միշտ դրվում է կապակցվող քարտեզի (նկարի) վրա (նկ. 44): 

 



40  

 

Նկ. 44. Առանց կոորդինատային ցանցի նկարի գեոկապակցման 

գործընթացը 

 

Տեսնում ենք, որ դրված կետի մոտ սահմանները համընկ-

նում են, բայց այլ հատվածներում շեղումը դեռ մեծ է: Այդ 

պատճառով գործողությունը կրկնում ենք այլ կետի համար, 

որը պետք է հեռու լինի դրված կետից (նկ. 45): 

 

 

Նկ. 45. Առանց կոորդինատային ցանցի նկարի գեոկապակցման 

գործընթացը 
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Երկրորդ կետը դնելուց հետո ԲՀՊՏ քարտեզում ներկա-

յացված սահմանները համընկան մարզերի վեկտորային շեր-

տի սահմանների հետ (նկ. 46): Համընկնումը կարող է լիարժեք 

չլինել, քանի որ տարբեր են մասշտաբները: 
 

 

Նկ. 46. Առանց կոորդինատային ցանցի նկարի գեոկապակցման 

գործընթացը 
 

Հաճախ երկու կետը բավարար է լինում գեոկապակցման 

համար, բայց լինում են դեպքեր, երբ պետք է լինում տեղադրել 

երեք և ավելի կետեր: Սակայն շատ կետերը երբեմն կարող են 

ավելի մեծ շեղումներ առաջացնել: Եթե կետը դնելուց հետո 

շեղումը մեծանում է, այն պետք է ջնջել Link աղյուսակից` 

նշելով այն և սեղմելով ստեղնաշարի Delete կոճակը: 

Կետերի տեղադրման գործընթացն ավարտելուց հետո 

պետք է պահել քարտեզը կոորդինատային համակարգով ինչ-

պես դա արվեց տեղագրական քարտեզի գեոկապակցման 

դեպքում՝ Georeferencing մենյուից ընտրելով Update 

Georeferencing-ի կամ Rectify-ի հնարավորությունները: 
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2.3 Պրոյեկցիայի որոշում 

 

Երբեմն տարածական ֆայլերը կարող են ի սկզբանե չու-

նենալ կոորդինատային համակարգ, օրինակ՝ մինչև թվայնա-

ցումը սկսելը այն կցված չլինի ֆայլին: Կոորդինատային 

համակարգը կարող է տրվել ֆայլին նաև թվայնացումից հե-

տո՝ օգտագործելով Define Projection գործիքը՝ ArcToolbox => 

Data Management Tools => Projections and Transforamtions => 

Define Projection: Input Dataset or Feature Class դաշտում 

անհրաժեշտ է նշել առանց կոորդինատային համակարգի 

ֆայլը, Coordinate System-ում՝ նախընտրելի կոորդինատային 

համակարգը և սեղմել OK կոճակը (նկ. 47): 

 

 
Նկ. 47. Պրոյեկցիայի որոշում 

 

 

 



43  

2.4 Պրոյեկտավորում (Project) 

 

Երբեմն տարբեր աղբյուրներից ստացված տարածական 

շերտերն ունենում են տարբեր կոորդինատային համակար-

գեր: Համատեղ օգտագործման համար անհրաժեշտ է դրանց 

բերել միևնույն կոորդինատային համակարգի: Վեկտորային 

շերտի կոորդինատային համակարգը փոխելու համար 

անհրաժեշտ է օգտագործել Project գործիքը՝ ArcToolbox => 

Data Management Tools => Projections and Transforamtions => 

Project: Input Dataset or Feature Class դաշտում անհրաժեշտ է 

նշել այն վեկտորային շերտը, որի կոորդինատային համա-

կարգը պետք է փոխել, Input Coordinate System-ում երևում է 

այդ վեկտորային շերտի ներկա կոորդինատային համակար-

գը, Output Dataset or Feature Class դաշտում պետք է նշել նոր 

կոորդինատային համակարգով ելքային ֆայլի պահման 

վայրը և անունը, Output Coordinate System-ում՝ նախընտրելի 

նոր կոորդինատային համակարգը, Geographic Transformation 

դաշտում կարելի է ընտրել մի համակարգից մյուսին անցնելու 

ալգորիթմը և սեղմել OK կոճակը (նկ. 48): 
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Նկ. 48. Պրոյեկտավորում 

 

Ռաստրային ֆայլերի համար պրոյեկտավորումն իրակա-

նացվում է Project Raster գործիքով՝ ArcToolbox => Data 

Management Tools => Projections and Transforamtions => Raster 

=> Project Raster: 
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3. Քարտեզների կազմում (Layout View) 

 

Առկա ԱՏՀ տվյալների հիման վրա քարտեզներ կազմելու 

համար պետք է «Տվյալների տեսք» մենյուից  (Data View) ան-

ցում կատարել «Ձևավորման տեսք» մենյու (Layout View): 

Անհրաժեշտ է ավելացնել Layout գործիքների պանելը: Layout 

View-ում աշխատելիս օգտագործելու ենք նաև Insert մենյուի 

գործիքները (նկ. 49): 

 

 

Նկ. 49. Layout View-ում աշխատանքի սկիզբ 

 

Layout պանելի գործիքները թույլ են տալիս մոտեցնել, 

հեռացնել, տեղաշարժել պատկերը, դիտել ամբողջ էջը կամ 

պատկերը իրական չափով: Insert մենյուից կարելի է ավելաց-

նել քարտեզի վերնագիր (Title), հյուսիսի նշան (North Arrow), 

մասշտաբ (Scale Text, Scale Bar), պայմանական նշաններ 

(Legend), տեքստ (Text) և այլն: 

Էջի չափերը և ուղղվածությունը փոփոխելու համար 

անհրաժեշտ է File մենյուից մտնել Page and Print Setup (նկ. 50): 
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Նկ. 50. Էջի կարգավորումների պատուհան (Page and Print Setup) 

 

Քարտեզը կազմելիս պետք է առաջին հերթին ուշադրու-

թյուն դարձնել պայմանական նշաններին: Դրանք պետք է ըն-

թեռնելի դարձնեն քարտեզում ներկայացված շերտերը: Պայ-

մանական նշանը կարող է ընդհանուր լինել ամբողջ շերտի 

համար կամ դասակարգված ըստ որևէ ատրիբուտային դաշ-

տի արժեքների (օրինակ՝ կարելի է դասակարգել ԲՀՊՏ-երն 

ըստ անունների): Առաջին դեպքում պետք է սեղմել շերտի ան-

վան տակ դրա նշանի վրա Table of Contents պատուհանում, 

երկրորդ դեպքում՝ մկնիկի աջ կոճակով սեղմել շերտի անվան 

վրա => Properties => Symbology (նկ. 51): 

 



47  

 

Նկ. 51. Շերտերի նշանների՝ ըստ ատրիբուտների դասակարգման 

մենյու (Symbology) 

 

Value Field մենյուից պետք է ընտրել այն դաշտը, ըստ որի 

պետք է իրականացվի դասակարգումը, այնուհետև անհրա-

ժեշտ է սեղմել Add All Values կոճակը, որից հետո կհայտնվեն 

ընտրված դաշտում առկա բոլոր յուրահատուկ արժեքները: 

Գունային սխեման կարելի է կարգավորել Color Ramp մենյուի 

միջոցով կամ կուրսորով սեղմել յուրաքանչյուր արժեքի կող-

քին գտնվող գունային դաշտի վրա: 

Տեղադրենք քարտեզի վրա հյուսիսի նշան: Insert մենյուից 

պետք է սեղմել North Arrow կոճակը և ընտրել առաջարկվող 

նշանի տարբերակներից մեկը (նկ. 52): 
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Նկ. 52. Հյուսիսի նշանի ավելացում քարտեզի վրա 

 

Մասշտաբի ներկայացման համար նախընտրելի է գծային 

տարբերակը, քանի որ քարտեզը մեծացնելիս կամ փոքրաց-

նելիս այն կպահպանի իր ճշտությունը: Insert մենյուից պետք է 

սեղմել Scale Bar կոճակը և բացված պատուհանից ընտրել 

առաջարկվող գծային մասշտաբի տարբերակներից մեկը (նկ. 

53): 

 

 

Նկ. 53. Գծային մասշտաբի ավելացում քարտեզի վրա 
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Գծային մասշտաբը կարելի է կարգավորել (փոխել չափ-

ման միավորները, չափերը, լեզուն և այլն)՝ աջ քլիք անելով 

դրա վրա, այնուհետև՝ Properties (նկ. 54): 

 

 
Նկ. 54. Գծային մասշտաբի կարգավորումների պատուհան 

 

Հաջորդ քայլով քարտեզի վրա ավելացնենք պայմանա-

կան նշանների ցուցակը` Insert մենյուից սեղմելով Legend 

կոճակը: Բացված պատուհանում նախ պետք է ընտրել, թե որ 

շերտերը պետք է երևան պայմանական նշաններում (նկ. 55): 

 

 
Նկ. 55. Պայմանական նշանների ավելացման պատուհան 
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Սեղմելով Next՝ կբացվի պատուհան, որտեղ պետք է լրաց-

նել պայմանական նշանների ցուցակի վերնագիրը՝ Պայմա-

նական նշաններ (նկ. 56): 

 

 
Նկ. 56. Պայմանական նշանների կարգավորումներ 

 

Հաջորդ պատուհանում հարկավոր է ընտրել պայմանա-

կան նշանների սահմանը, հետին ֆոնի գույնը և այլն (նկ. 57): 

 

 

Նկ. 57. Պայմանական նշանների կարգավորումներ 
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Հաջորդ պատուհանում պետք է ընտրել գծային և պոլիգո-

նալ շերտերի նշանները, որոնք կերևան պայմանական նշան-

ների ցուցակում (նկ. 58): 

 

 

Նկ. 58. Պայմանական նշանների կարգավորումներ 

 

Սեղմելով Next՝ կբացվի պատուհան, որտեղ կարելի է 

կարգավորել պայմանական նշանների տարրերի միջև միջա-

կայքերի չափերը (նկ. 59): 
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Նկ. 59. Պայմանական նշանների կարգավորումներ 

 

Սեղմելով Finish կոճակը՝ պայմանական նշանները կավե-

լանան քարտեզի վրա: Կարելի է նաև ավելացնել քարտեզի 

վերնագիրը՝ Insert =>Title: 

Ստացված քարտեզը նկարի տեսքով պահելու համար 

պետք է File մենյուից սեղմել Export կոճակը (նկ. 60): 

 

 
Նկ. 60. Քարտեզի արտահանում նկարի տեսքով 
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Բացված պատուհանում պետք է ընտրել աշխատանքային 

տարածքը, որտեղ պետք է պահել ֆայլը, ինչպես նաև ֆայլի 

գրաֆիկական ձևաչափը (նկ. 61): 

 

 

Նկ. 61. Քարտեզի արտահանում նկարի տեսքով 

 

Հաճախ անհրաժեշտ է լինում քարտեզի մի հատվածը 

ներկայացնել դրա վրա մեծացված տարբերակով: Օրինակ՝ 

ունենք ՀՀ ԲՀՊՏ քարտեզ, որի վրա պետք է առանձին, ավելի 

մեծ չափով ներկայացված լինի «Դիլիջան» ազգային պարկը: 

Դրա համար Insert մենյուից քարտեզի վրա պետք է ավելացնել 

նոր Data Frame (նկ. 62): 
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Նկ. 62. Նոր Data Frame-ի ավելացում նախագծին 

 

Նշելով Data Frame-ը քարտեզի վրա՝ կարելի է ավելացնել 

հետաքրքրող շերտերը դրա մեջ Add Data-ի կամ Add          

Basemap-ի միջոցով կամ պատճենել Layers Data Frame-ի շեր-

տերը: Ավելացնենք ԲՀՊՏ շերտը և արբանյակային նկար Add 

Basemap-ի միջոցով New Data Frame-ի մեջ և մոտեցնենք պատ-

կերը «Դիլիջան» ազգային պարկի վրա (նկ. 63): 
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Նկ. 63. New Data Frame-ը «Դիլիջան» ազգային պարկի վրա 

մոտեցված պատկերով 

 

Անջատենք ԲՀՊՏ շերտը New Data Frame-ում: Այժմ կապ 

ստեղծենք երկու քարտեզների միջև՝ հիմնական քարտեզի 

վրա ցույց տանք, թե որ տարածքն է պատկերված փոքր քար-

տեզի վրա: Դրա համար անհրաժեշտ է մկնիկի աջ կոճակով 

սեղմել Layers-ի վրա, այնուհետև՝ Properties =>Extent Indicators, 

որտեղից պետք է ընտրել New Data Frame-ը և սեղմել սլաքի 

նշանի վրա (նկ. 64): 
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Նկ. 64. Երկու քարտեզների միջև կապի ստեղծում 

 

Միացնենք Show Leader-ը, որը երկու քարտեզները կապող 

գիծ է և սեղմենք OK (նկ. 64): 

 

 

Նկ. 64. Երկու քարտեզների միջև կապի ստեղծում 
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Արդյունքում կստացվի հետևյալ պատկերը (նկ. 65)։ 
 

 

Նկ. 65. Երկու քարտեզների միջև կապը 

 

Վեկտորային օբյեկտների պիտակները (labels) քարտեզի 

վրա ներկայացնելու համար անհրաժեշտ է մկնիկի աջ կոճա-

կով սեղմել հետաքրքրող վեկտորային շերտի վրա, այնու-

հետև՝ Proiperties => Labels: Պետք է միացնել Label features in 

this layer-ը, Label Field վայր ընկնող մենյուից ընտրել վեկտո-

րային շերտի ատրիբուտային աղյուսակի այն դաշտը, որի ար-

ժեքները պետք է երևան քարտեզի վրա, Text Symbol հատվա-

ծում կարգավորել պիտակների տառատեսակը, գույնը, տա-

ռաչափը և այլն (նկ. 66): 
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Նկ. 66. Պիտակների կարգավորում (Labels) 

 

Սեղմելով OK կոճակը՝ վեկտորային շերտի օբյեկտների 

պիտակները կհայտնվեն քարտեզի վրա (նկ. 67): 

 

 

Նկ. 67. ԲՀՊՏ շերտի օբյեկտների պիտակները (Labels) 
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4. Տարբեր ֆորմատների տվյալների ներմուծում 

 

4.1 XY կոորդինատային տվյալների ավելացում որպես 

շերտ 

 

Բացի այնպիսի տվյալների ֆորմատներից՝ ինչպիսին, 

օրինակ, շեյփֆայլերն ու ռաստրային ֆայլերն են, քարտեզի 

վրա կարելի է ավելացնել նաև աղյուսակային տվյալներ, 

որոնք պարունակում են X, Y զույգ կոորդինատների տեսքով 

աշխարհագրական օբյեկտներ: Եթե աղյուսակային տվյալները 

պարունակում են նաև Z արժեքներ, դրանք կարելի է ավե-

լացնել որպես եռաչափ շերտեր ArcGlobe-ում և ArcScene-ում 

օգտագործելու համար: 

X, Y կոորդինատները նկարագրում են կետերի տեղա-

դիրքը երկրի մակերևույթի վրա, օրինակ՝ ջրառի վայրերի կամ 

բնության հուշարձանների տեղադիրքը: Նման X,Y կոորդի-

նատները կարելի է հեշտությամբ հավաքագրել GPS ընդունիչի 

միջոցով: 

Աղյուսակը պետք է պարունակի կետերի X և Y կոորդի-

նատներ պարունակող դաշտեր (Z կոորդինատը պարունակող 

դաշտը լրացուցիչ է): Դաշտերը պետք է լինեն թվային՝ աստի-

ճանային արժեքներ, և պետք է ներկայացվեն տասնորդական 

աստիճանների տեսքով (Decimal degrees) (նկ. 68): 
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Նկ. 68. X, Y տվյալներով աղյուսակ 

 

Աղյուսակն ավելացնելու համար նախ «Տվյալների շրջա-

նակին» (Data frame) պետք է տալ աշխարհագրական կոորդի-

նատային համակարգ: Դրա համար պետք է մկնիկի աջ կոճա-

կով սեղմել Layers-ի վրա, այնուհետև՝ Properties և Coordinate 

Systems ներդիրում ընտրել WGS 1984 կոորդինատային համա-

կարգը: Դրանից հետո ArcMap-ի File մենյուից անհրաժեշտ է 

ընտրել Add Data, այնուհետև՝ Add XY Data (նկ. 69): 
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Նկ. 69. XY տվյալներով աղյուսակի ավելացում 

 

Բացված պատուհանում պետք է ընտրել տվյալները պա-

րունակող աղյուսակը, X, Y, Z արժեքները պարունակող դաշ-

տերը և սեղմել OK: 

Աղյուսակը կավելանա ArcMap-ում: Տվյալները որպես 

տարածական շերտ օգտագործելու համար պետք է պահել 

շեյփֆայլի կամ գեոտվյալների բազայի շերտի տեսքով: Դրա 

համար պետք է մկնիկի աջ կոճակով սեղմել աղյուսակի ան-

վան վրա, այնուհետև Data => Export Data, որտեղ պետք է 

ընտրել ստեղծվող շերտի պահման վայրը և անունը: 
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4.2 KML ֆայլերի ներմուծում 

 

KML կամ KMZ ֆայլերը, որոնք կարող են արտահանվել՝ 

օրինակ, Google Earth-ից, հնարավոր է ներմուծել ArcMap և 

պահել վեկտորային ֆայլերի տեսքով: 

KML կամ KMZ ֆայլի ներմուծման համար անհրաժեշտ է 

ArcToolbox-ից ընտրել Conversion Tools գործիքների խումբը, 

այնտեղից՝ From KML => KML to Layer (նկ. 70): 

 

 
Նկ. 70. KML ֆայլի ներմուծում 

 

Դրանից հետո բացված պատուհանում Input Kml File դաշ-

տում պետք է մուտքագրել ներմուծվող KML կամ KMZ ֆայլը 

(նկ. 71): 
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Նկ. 71. KML ֆայլի ներմուծում 

 

Ներմուծված ֆայլը կարող է պարունակել կետային, գծա-

յին և պոլիգոնալ տվյալներ (Points, Polylines, Polygons): Այդ 

տվյալները վեկտորային շերտի տեսքով պահելու համար 

անհրաժեշտ է մկնիկի աջ կոճակով սեղմել տվյալների տիպի 

անվան վրա, այնուհետև՝ Data => Export Data, որտեղ պետք է 

ընտրել ստեղծվող շերտի պահման վայրն ու անունը (նկ. 72): 
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Նկ. 72. KML ֆայլի արտահանում վեկտորային ֆայլի տեսքով 

 

4.3 CAD ֆայլերի ներմուծում 

 

AutoCAD ծրագրով ստեղծված ֆայլերը (DWG, DXF) կա-

րող են նույնպես ներմուծվել ArcGIS և պահվել տարածական 

վեկտորային շերտերի տեսքով: Նախ անհրաժեշտ է Add Data 

կոճակով ավելացնել հետաքրքրող CAD ֆայլը (նկ. 73): 

 

 

Նկ. 73. «Արևիկ» ազգային պարկի տարածքը ներկայացնող CAD 

ֆայլը 
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Ֆայլն ավելացնելուց հետո Table of Contents-ում կարող 

ենք տեսնել, որ այն բաժանված է մի քանի մասի՝ Annotation, 

Point, Polyline, Polygon, MultiPatch: Այսինքն՝ օբյեկտները բա-

ժանված են մասերի ըստ իրենց երկրաչափական տիպի: Բա-

ցելով Polyline-ի ատրիբուտային աղյուսակը՝ կարող ենք տես-

նել, որ բոլոր օբյեկտները՝ սահմանները, ճանապարհները, գե-

տերը (և այլն) գտնվում են նույն Polyline շերտում: Դրանք կա-

րող ենք իրարից տարբերել Layer դաշտի գրառումներով (նկ. 

74): 

 

 

Նկ. 74. AutoCAD ֆայլի Polyline շերտի ատրիբուտային աղյուսակը 

 

Որևէ օբյեկտների խումբ առանձնացնելու և առանձին 

վեկտորային շերտի տեսքով պահելու համար պետք է այն նշել 

աղյուսակում, այնուհետև մկնիկի աջ կոճակով սեղմել Polyline 

շերտի վրա, դրանից հետո՝ Data => Export Data, որտեղ պետք է 

նշել պահվող ֆայլի (շեյփֆայլ կամ գեոտվյալների բազայի 

շերտ) վայրն ու անունը (նկ. 75): 
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Նկ. 75. Սահմանների շերտի առանձնացումը «Արևիկ» ազգային 

պարկի CAD ֆայլի Polyline շերտից 

 

Արդյունքում ստեղծված շերտը կավելանա ArcMap-ում 

(նկ. 76): 

 

 

Նկ. 76. Սահմանների վեկտորային շերտը ստացված CAD ֆայլից 

 

Շերտի կոորդինատային համակարգը որոշելու համար 

պետք է օգտագործել Define Projection գործիքը: 
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5. Հարցումներ, ընտրումներ և առանձնացում 

 

5.1 Ընտրում ըստ ատրիբուտների (Select by Attributes) 

 

Ընտրումները թույլ են տալիս դուրս բերել տվյալների 

բազմությունից մեզ հետաքրքրող տվյալներն ըստ որոշակի 

հատկանիշների: Հետաքրքրող տվյալների առանձնացման 

համար պետք է իրականացնել տվյալների/դրանց հարցում: 

Հարցումը արտահայտություն է, որի միջոցով ընդհանուր 

տվյալներից դուրս է բերվում մասնավոր տեղեկատվություն 

(նկ. 77): 

Որևէ ատրիբուտային տվյալ ընտրելու համար Selection 

մենյուից անհրաժեշտ է սեղմել Select by Attributes կոճակը: 

Նկ. 77. Ըստ ատրիբուտների ընտրության պատուհան 

 

Բացված պատուհանում Layer (վայր ընկնող) մենյուից 

պետք է ընտրել այն շերտը, որից պետք է ընտրվեն հե-
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տաքրքրող տվյալները: Այս օրինակում կդիտարկենք բնու-

թյան հուշարձանների կետային շերտը՝ «natural_monuments»: 

Method վայր ընկնող մենյուում կա 4 հնարավորություն՝ 

Ստեղծել նոր ընտրություն (Create New Selection), Ավելացնել 

ընտրությանը (Add to Current Selection), Հեռացնել ընտրու-

թյունից (Remove from Current Selection), Ընտրել ընտրու-

թյունից (Select from Current Selection): Ընտրենք առաջին տար-

բերակը՝ ստեղծենք նոր ընտրության համար հարցում: Այնու-

հետև պետք է ընտրել ատրիբուտային աղյուսակի այն դաշտը, 

որում պետք է կատարվի հարցումը:  Ընտրենք  բնության  հու-

շարձանների  տիպը  ներկայացնող  դաշտը՝ «Type_eng»: Եր-

կու անգամ մկնիկի ձախ կոճակով սեղմելով դաշտի անվան 

վրա՝ այն կհայտնվի արտահայտության տողում: Դրանից հե-

տո պետք է ավելացնել հարցման մաթեմատիկական օպերա-

տորը: Քանի որ մեզ հետաքրքրող տվյալները լրացված են 

տեքստի տեսքով, հարցման մեջ պետք է տեղադրել = նշանը: 

Եթե հարցումը իրականացվեր թվային դաշտի, ապա կարող 

ենք օգտագործել >, < և այլ մաթեմատիկական օպերատորներ 

(օրինակ, բնակչության քանակը > 10000): 

Սեղմելով Get Unique Values կոճակը՝ կհայտնվեն հարց-

ման դաշտի բոլոր ունիկալ արժեքները: Ընտրենք հիդրոլո-

գիական և բուսաբանական բնության հուշարձանները: Դրա 

համար պետք է կրկնակի սեղմել «Hydrological» արժեքի վրա, 

այնուհետև ընտրել OR օպերատորը և կրկնել հարցման ար-

տահայտությունը բուսաբանական հուշարձանների համար և 

սեղմել OK կոճակը (նկ. 78): 
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Նկ. 78. Հիդրոլոգիական և բուսաբանական բնությունների 

հուշարձանների ընտրում 

 

OK կոճակը սեղմելուց հետո կընտրվեն հարցման պայ-

մանին բավարարող օբյեկտները: Դրանք կապույտ գույնով 

կնշվեն ինչպես քարտեզի վրա, այնպես էլ ատրիբուտային 

աղյուսակում (նկ. 79): 

 



70  

  

 
Նկ. 79. Ըստ ատրիբուտների ընտրության արդյունքները 

 

5.2  Select գործիք (Analysis Tools) 

 

Ատրիբուտային հարցման արդյունքները կարելի է նաև 

անմիջապես պահել նոր շերտի տեսքով՝ օգտագործելով Select 

գործիքը: Այն գործարկելու համար անհրաժեշտ է ArcToolbox-ից 

ընտրել Analysis Tools => Extraction => Select (նկ. 80): 
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Նկ. 80. Select գործիքի պատուհան 

 

Input Features դաշտում պետք է ընտրել այն շերտը, որում 

պետք է կատարվի հարցումը, Output Feature Class դաշտում՝ 

ընտրման արդյունքում ստեղծվող նոր շերտի պահման տեղը 

և անունը: Expression դաշտի հարևանությամբ գտնվող SQL կո-

ճակը սեղմելով՝ կբացվի ատրիբուտային հարցման պատու-

հանը: Ընտրենք և նոր շերտի տեսքով պահենք Հայաստանի 

20000-ից ավելի բնակչություն ունեցող բնակավայրերը՝ ՀՀ 

բնակավայրերի ընդհանուր շերտից (նկ. 81): 

 

 

Նկ. 81. Ատրիբուտային հարցման կառուցման պատուհան 
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Սեղմելով Ok կոճակը տվյալ պատուհանում, այնուհետև՝ 

Select գործիքի պատուհանում, ծրագիրը կիրականացնի հար-

ցումը և կկառուցի նոր շերտ, որը կավելանա քարտեզի վրա: 

Անջատելով ՀՀ բնակավայրերի ընդհանուր շերտը՝ կարող ենք 

տեսնել հարցման արդյունքները (նկ. 82): 

 

 

Նկ. 82. Select գործիքի կիրառման արդյունքները 

 

5.3 Ընտրում ըստ տարածքի (Select by Location) 

 

Select by Location-ը թույլ է տալիս ընտրել հետաքրքրող 

տարածքում գտնվող օբյեկտները: Ենթադրենք, ՀՀ անտառ-

ների վեկտորային շերտից մեզ պետք է առանձնացնել միայն 

Տավուշի մարզում ընկած անտառները: ArcMap նախագծում 

ավելացնենք մարզերի և անտառների վեկտորային շերտերը: 

Ընտրենք Տավուշի մարզը: Selection մենյուից ընտրենք Select 

by Location հնարավորությունը: Բացված պատուհանում 

Tareget Layer(s) հատվածում նշենք անտառների շերտը, իսկ 
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Source Layer-ում՝ մարզերը: Պետք է նշել նաև Use Selected 

Features հնարավորությունը, որպեսզի ընտրվեն միայն նշված 

մարզում ընկած անտառները (նկ. 83): 

 

 

Նկ. 83. Ընտրում ըստ տարածքի. Տավուշի մարզի անտառների 

առանձնացումը ՀՀ անտառների շերտից 

 

Սեղմելով OK կոճակը՝ քարտեզի վրա և ատրիբուտային 

աղյուսակում կնշվեն հարցման արդյունքները (նկ. 84): 

 

 

Նկ. 84. Ըստ տարածքի ընտրման արդյունքները 
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5.4 Clip գործիք (Analysis Tools) 

 

Clip գործիքը թույլ է տալիս վեկտորային շերտից կտրել և 

նոր շերտի տեսքով պահել հետաքրքրող տարածքի օբյեկտ-

ները (նկ. 84): 

 

Մուտքային տվյալներ             Կտրող օբյեկտ          Ելքային տվյալներ 

Նկ. 84. Clip գործիքի աշխատանքը 

 

Clip գործիքի միջոցով ՀՀ լանդշաֆտային գոտիների շեր-

տից առանձնացնենք Լոռու մարզի լանդշաֆտային գոտիները: 

Ավելացնենք ArcMap-ում լանդշաֆտային գոտիների և մարզե-

րի շերտերը: Մարզերի շերտից ընտրենք Լոռու մարզը, որից 

հետո գործարկենք Clip գործիքը՝ ArcToolbox => Analysis Tools 

=> Extraction => Clip: Input Features դաշտում նշենք լանդշաֆ-

տային գոտիների շերտը, Clip Features-ում՝ մարզերի շերտը, 

Output feature class-ում նշենք, թե որտեղ պետք է պահվի ել-

քային ֆայլը և դրա անունը (նկ. 85): 
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Նկ. 85. Clip գործիքի պատուհան 

 

Պահանջվող պարամետրերն ընտրելուց և OK կոճակը 

սեղմելուց հետո Լոռու մարզի լանդշաֆտային գոտիների շեր-

տը կավելանա ArcMap-ում (նկ. 86): 

 

 

Նկ. 86. Clip գործիքի կիրառման արդյունքները 
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6. Միացումներ և կապակցումներ 

 

6.1 Միացում (Join) 

 

Ընդհանուր դաշտի միջոցով (բանալի դաշտ) հնարավոր է 

կապել մի աղյուսակի գրառումները մյուսի հետ: Օրինակ՝ կա-

րելի է կապել ջրօգտագործման թույլտվությունների նկարա-

գրական տվյալները, որոնք պահվում են Excel ֆայլում, ՋԹ 

վեկտորային շերտի հետ: Դրա համար անհրաժեշտ է ArcMap-

ում ավելացնել ՋԹ շերտը, համոզվել, որ ատրիբուտային աղ-

յուսակում կա ID դաշտ, որի արժեքներին համապատասխան 

գրառումներ կան միացվող աղյուսակում (նկ. 87): 

 

 

Նկ. 87. ՋԹ շերտի ատրիբուտային աղյուսակը և Excel ֆայլ, որտեղ 

ներկայացված են ՋԹ- ների բնութագրիչները: Երկու աղյուսակների 

ID դաշտերի արժեքները համընկնում են 

 

Միացման և կապակցման մենյուին անցնելու համար 

պետք է մկնիկի աջ կոճակով սեղմել ՋԹ վեկտորային շերտի 

անվան վրա: Բացված մենյուից պետք է ընտրել Join and 

Relates, այնուհետև՝ Join (նկ. 88): 
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Նկ. 88. Աղյուսակների միացում (Join) 

 

Սեղմելով Join կոճակը կբացվի աղյուսակների միացման 

պատուհանը: 1-ին կետում պետք է ընտրել ատրիբուտային 

աղյուսակի այն դաշտը, որի վրա պետք է հիմնված լինի միա-

ցումը (ID), 2-րդ կետում՝ միացվող աղյուսակը, 3-րդում՝ միաց-

վող աղյուսակի այն դաշտը, որը համապատասխանում է ատ-

րիբուտային աղյուսակի ID դաշտին (նկ. 78): Join Options-ում 

կա երկու հնարավորություն՝ պահպանել ատրիբուտային աղ-

յուսակի բոլոր գրառումներն անկախ նրանից, թե միացվող 

աղյուսակում դրանց համապատասխան գրառումներ կան, թե 

ոչ, կամ պահպանել միայն համընկնող գրառումները (նկ. 89): 
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Նկ. 89. Աղյուսակների միացման պատուհանը 

 

Միացման պատուհանում բոլոր պարամետրերն ընտրե-

լու և OK սեղմելուց հետո ՋԹ շերտի ատրիբուտային աղյուսա-

կում կավելանան նկարագրական տվյալները միացվող աղյու-

սակից (նկ. 90): 
 

 
Նկ. 90. ՋԹ շերտի աղյուսակը միացումից հետո 
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Միացված տվյալները հեռացնելու համար պետք է Joins 

and Relates մենյուից սեղմել Remove joins կոճակը, որտեղ կա 

հնարավորություն հեռացնել կոնկրետ միացումը կամ բոլոր 

միացումները, եթե դրանք մեկից ավելի են: 

Միացումից հետո տվյալներն ատրիբուտային աղյուսա-

կում կպահպանվեն միայն բացված ArcMap նախագծում: Եթե 

անհրաժեշտ է, որ տվյալները մշտապես կցվեն, ապա պետք է 

արտահանել շերտը նոր շերտի տեսքով՝ մկնիկի աջ կոճակով 

սեղմելով դրա անվան վրա, այնուհետև՝ Data => Export Data: 

 

6.2 Կապակցում (Relate) 

 

Հնարավոր է նաև կապակցել երկու վեկտորային շերտերի 

տվյալներն ըստ ընդհանուր ատրիբուտային դաշտի՝ առանց 

աղյուսակներն իրար միացնելու: Օրինակ՝ կարելի է կապակ-

ցել մարզերի և բնական հուշարձանների շերտերը, ինչը թույլ 

կտա տեսնել, թե ինչ բնական հուշարձաններ կան ընտրված 

մարզում: Այդ նպատակով պետք է մկնիկի աջ կոճակով սեղ-

մել մարզերի շերտի անվան վրա, այնուհետև՝ Joins and Rlates 

=> Relate: Բացված պատուհանում 1-ին կետում պետք է 

ընտրել մարզերի շերտի այն դաշտը, որի վրա պետք է 

հիմնված լինի կապակցումը (marz_name), 2-րդ կետում՝ այն 

վեկտորային շերտը,  որը պետք  է կապակցվի մարզերի  շեր-

տին, 3-րդ  կետում՝ կապակցվող շերտի ատրիբուտային դաշ-

տը, որն ընդհանուր է մարզերի շերտի կապակցման համար 

հիմք հանդիսացող դաշտի հետ (marz_name): 4-րդ կետում 

տրվում է կապակցման անվանումը (քանի որ կապակցում-

ները կարող են լինել մեկից ավելի) (նկ. 91): 
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Նկ. 91. Բնական հուշարձանների շերտի կապակցումը մարզերի 

շերտին 

 

OK կոճակը սեղմելուց հետո բացենք մարզերի շերտի ատ-

րիբուտային աղյուսակը և ընտրենք որևէ մարզ: Այդ մարզում 

ընկած բնության հուշարձանների ցուցակը տեսնելու համար 

անհրաժեշտ է սեղմել Related Tables կոճակը և ընտրել Relate1 

(մեր կազմած կապակցման անվանումը) (նկ. 92): 

 

 
Նկ. 92. Մարզերի և բնական հուշարձանների շերտերի 

աղյուսակների միջև կապի դիտում 
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Սեղմելով կապի անվան վրա կբացվի բնական հուշար-

ձանների ատրիբուտային աղյուսակը, որտեղ ընտրված կլի-

նեն այն օբյեկտները, որոնք գտնվում են հետաքրքրող մար-

զում (նկ. 93): 

 

 
Նկ. 93. Մարզերի և բնական հուշարձանների շերտերի աղյուսակների 

միջև կապի դիտում 

 

Կապակցումը հեռացնելու համար պետք է մարզերի շեր-

տի վրա մկնիկի աջ կոճակով սեղմելով բացել Join and Relates 

մենյուն, այնուհետև՝ Remove Relate(s) և ընտրել այն կապակ-

ցումը, որը պետք է հեռացվի: 

 

6.3 Տարածական միավորում (Spatial Join) 

 

Տարածական միավորման միջոցով թիրախային շերտի 

ատրիբուտային աղյուսակին են միավորվում միացվող շերտի 

ատրիբուտային տվյալները՝ հիմնվելով այդ շերտերի օբյեկտ-

ների տարածական հարաբերությունների վրա: 

Տարածական միավորման գործողությունն իրականաց-

վում է երկու տարբերակով՝ մեկը մեկին (Join_One_to_One) և 

մեկը շատին (Join_One_to_Many): Դիտարկենք երկու տարբե-
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րակները բնական հուշարձանների և մարզերի շերտերի հի-

ման վրա: 

Join One to One մեթոդով կարելի է հաշվարկել, թե բնու-

թյան քանի հուշարձան է ընկնում յուրաքանչյուր մարզի տա-

րածքում, սակայն չի կարելի դիտել այդ հուշարձանների ցու-

ցակը: Բացենք Spatial Join գործիքի պատուհանը՝ ArcToolbox 

=> Analysis Tools => Overlay => Spatial Join: Target Features 

դաշտում ընտրենք մարզերի շերտը, Join Features դաշտում՝ 

բնության հուշարձանների շերտը: Output Feature Class դաշ-

տում պետք է ընտրել ելքային ֆայլի պահման վայրն ու անու-

նը: Join Operation դաշտում վայր ընկնող մենյուից ընտրենք 

առաջին տարբերակը՝ Join_One_to_One: 

Եթե նշված է Keep All Target Features հնարավորությունը, 

ապա ելքային ֆայլում կպահպանվեն թիրախային շերտի բո-

լոր օբյեկտները, անկախ նրանից, թե միացվող շերտում կան 

դրանց համապատասխանող գրառումներ, թե ոչ: 

Field Map of Join Features պատուհանում ընտրվում են 

երկու շերտերի ատրիբուտային աղյուսակների այն դաշտերը, 

որոնք պետք է լինեն ելքային շերտի ատրիբուտային աղյուսա-

կում: Match Option վայր ընկնող մենյուից ընտրվում է երկու 

շերտերի միջև տարածական հարաբերության տիպը: 

INTERSECT տարբերակը նշանակում է, որ բնական հուշար-

ձանները (միացվող շերտ) պետք է ընկած լինեն մարզերի 

շերտի տարածքում: Search Radius-I-ի միջոցով կարելի է տալ 

փնտրման շառավիղ մարզերի սահմանից, որի տարածքում 

ընկած կետերը նույնպես կմիացվեն մարզերի շերտին (նկ. 94): 
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Նկ. 94. Բնական հուշարձանների շերտի տարածական կապակցում 

մարզերի շերտին (Join One to One) 

 

OK կոճակը սեղմելուց հետո ելքային շերտը կավելանա 

ArcMap-ում: Բացելով դրա ատրիբուտային աղյուսակը՝ կտես-

նենք, որ, երկու շերտերի ատրիբուտներից բացի, այստեղ 

ավելացել է Join_Count դաշտը, որում ներկայացված արժեք-

ները ցույց են տալիս, թե քանի բնական հուշարձան կա յուրա-

քանչյուր մարզում (նկ. 95): 
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Նկ. 95. Տարածական միավորման արդյունքում ստեղծված նոր շերտի 

ատրիբուտային աղյուսակը (Join One to One) 

 

Այժմ կատարենք նույն գործողությունը՝ օգտագործելով 

Join One to Many տարբերակը: Մնացած մուտքային պարա-

մետրերը թողնենք նույնը (նկ. 96): 

 

 

Նկ. 96. Բնական հուշարձանների շերտի տարածական կապակցում 

մարզերի շերտին (Join One to Many) 
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Գործողության արդյունքում նույնպես կստանանք ելքա-

յին շերտ, որը կավելանա ArcMap-ում: Դրա ատրիբուտային 

աղյուսակում գրառումները կլինեն ավելի շատ, քան առաջին 

դեպքում: Գրառումների քանակը համապատասխանում է 

բնության հուշարձանների քանակին: Այսպիսով, ստանում 

ենք յուրաքանչյուր մարզում առկա բնության հուշարձանների 

ցուցակ՝ դրանց լիարժեք բնութագրերով (նկ. 97): 

 

 

Նկ. 97. Տարածական միավորման արդյունքում ստեղծված նոր շերտի 

ատրիբուտային աղյուսակը (Join One to Many) 
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7. Վրադրումային գործողությունների 

իրականացման այլ գործիքներ. Overlay 

գործիքների խումբ (Analysis Tools) 

 

Բացի վերը դիտարկված Տարածական միավորում գործի-

քից՝ Վրադրում (Overlay) գործիքների խումբը պարունակում է 

մի քանի տարածական շերտերի վրադրման համար նախա-

տեսված այլ գործիքներ և թույլ է տալիս միացնել, ջնջել կամ 

փոփոխել տարածական օբյեկտները՝ արդյունքները պահելով 

ելքային տարածական շերտում: Նոր տեղեկատվությունը 

ստացվում է տարածական մի շերտի՝ մյուսի հետ վրադրման 

եղանակով տարածական հարաբերությունների բացահայտ-

ման միջոցով: 

Ջնջում (Erase): Ստեղծում է տարածական շերտ մուտ-

քային օբյեկտների և ջնջող օբյեկտների (պոլիգոնալ) վրա-

դրման միջոցով: Ելքային շերտի մեջ պատճենվում են մուտ-

քային օբյեկտների միայն այն մասերը, որոնք դուրս են մնում 

ջնջող պոլիգոնների սահմաններից (նկ. 98): 

 

 

Մուտքային օբյեկտներ          Ջնջող օբյեկտ        Ելքային օբյեկտներ 

Նկ. 98. Ջնջում (Erase) գործիքի աշխատանքը 
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Նույնականություն (Identity): Հաշվարկում է մուտքային 

օբյեկտների և նույնականացման օբյեկտների միջև երկրաչա-

փական հատումը: Մուտքային օբյեկտներին կամ դրանց այն 

մասերին, որոնք համընկնում են նույնականացման օբյեկտ-

ների հետ, միացվում են դրանց նույնականացման համապա-

տասխան օբյեկտների ատրիբուտները (նկ. 99): 

 

Մուտքային օբյեկտներ   Ելքային օբյեկտներ 

 
Նույնականացման օբյեկտ 

Նկ. 99. Նույնականացում (Identity) գործիքի աշխատանքը 

 

Հատում (Intersect): Հաշվարկում է մուտքային օբյեկտների 

միջև երկրաչափական հատումը: Տարածական օբյեկտները 

կամ օբյեկտների մասերը, որոնք վրադրվում են բոլոր մուտ-

քային տարածական շերտերում, կգրանցվեն ելքային օբյետ-

ների շերտում (նկ. 100): 
 

Մուտքային օբյեկտներ  Ելքային օբյեկտներ 

 

Հատող օբյեկտներ 

Նկ. 100. Հատում (Intersect) գործիքի աշխատանքը 
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Սիմետրիկ տարբերություն (Symmetrical Difference): 

Ելքային տարածական շերտում գրանցվում են մուտքային և 

ճշգրտող տարածական օբյեկտների իրար հետ չհամընկնող 

հատվածները (նկ. 101): 

Մուտքային օբյեկտներ   Ելքային օբյեկտներ 

 

 

Նկ. 101. Սիմետրիկ տարբերություն (Symmetrical Difference) գործիքի 

աշխատանքը 

 

Միավորում (Union): Միավորում է մուտքային շերտերի 

օբյեկտները ելքային շերտի տեսքով: Ելքային շերտի ատրի-

բուտային աղյուսակում կգրանցվեն բոլոր օբյեկտները և 

դրանց ատրիբուտները (նկ. 102): 

Մուտքային օբյեկտներ      Ելքային օբյեկտներ 

 

Նկ. 102. Միավորում (Union) գործիքի աշխատանքը 

 

Թարմացում (Update): Հաշվարկում է մուտքային և 

ճշգրտող օբյեկտների երկրաչափական հատումը: Մուտքային 
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օբյեկտների երկրաչափությունն ու ատրիբուտները հատվող 

հատվածներում փոխարինվում են ճշգրտող օբյեկտների 

երկրաչափությամբ և ատրիբուտներով (նկ. 103): 

 

Մուտքային օբյեկտներ   Ելքային օբյեկտներ 

 

Ճշգրտող օբյեկտներ 

Նկ. 103. Թարմացում (Update) գործիքի աշխատանքը 
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8. Բուֆերային գոտիներ (Buffer) 

 

Բուֆերային գոտին վեկտորային շերտի շուրջ որոշակի 

տրված հեռավորությամբ պոլիգոնալ շերտ է: Այն իրենից կա-

րող է ներկայացնել, օրինակ, սանիտարական գոտի բնության 

հուշարձանի կամ ԲՀՊՏ-ի շուրջ, հեղեղավտանգ գոտի գետի 

ափերին և այլն: 

Կառուցենք բուֆերային գոտի «Դիլիջան» ազգային պարկի 

շուրջ: Ավելացնենք ԲՀՊՏ պոլիգոնալ շերտը ArcMap-ում և 

նշենք «Դիլիջան» ազգային պարկը: Բացենք Buffer գործիքի 

պատուհանը՝ ArcToolbox => Analysis Tools => Proximity => 

Buffer: Input Features դաշտում պետք է ընտրել ԲՀՊՏ շերտը, 

Output Feature Class-ում՝ կառուցվող բուֆերային շերտի պահ-

ման վայրն ու անունը, Linear Unit-ում՝ բուֆերային գոտու հե-

ռավորությունը սահմանագծից: Side Type վայր ընկնող մեն-

յուից ընտրված է FULL տարբերակը: Դա նշանակում է, որ կա-

ռուցվող բուֆերային գոտին կընդգրկի ինչպես 1000 մ շառավ-

ղով արտաքին տարածքը, այնպես էլ ազգային պարկի տա-

րածքը: Dissolve Type դաշտում ընտրված է All տարբերակը՝ 

տարբեր օբյեկտների իրար վրա ընկնող բուֆերային գոտի-

ները կմիավորվեն (նկ. 104): 
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Նկ. 104. Բուֆերային գոտու կառուցում պոլիգոնալ շերտի շուրջ 

 

OK կոճակը սեղմելուց հետո բուֆերային գոտին 

կհայտնվի ArcMap-ում (նկ. 105): 

 

 
Նկ. 105. «Դիլիջան» ազգային պարկի շուրջ կառուցված բուֆերային 

գոտին 

 

Կառուցենք 100 մետրանոց բուֆերային գոտի Վայոց ձորի 

մարզի գետերի աջ ափին: ՀՀ գետերի շերտին Select by 

Location-ի միջոցով Վայոց ձորի գետերն ընտրելուց հետո բա-

ցենք Buffer գործիքի պատուհանը և լրացնենք մուտքային պա-

րամետրերը: Այս դեպքում Side Type դաշտում պետք է ընտրել 

RIGHT տարբերակը, իսկ End Type-ում՝ ROUND (ROUND և 

FLAT տարբերակների բացատրությունը տե՛ս տեսական նյու-

թում) (նկ. 106): 
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Նկ. 106. Բուֆերային գոտիների կառուցում գծային օբյեկտների շուրջ 

 

OK կոճակը սեղմելուց հետո Վայոց ձորի գետերի աջ 

ափերի համար կառուցված բուֆերային շերտը կավելանա 

ArcMap-ում (նկ. 107): 

 

 
Նկ. 107. Վայոց ձորի մարզի գետերի աջ ափերի համար կառուցված 100 

մետրանոց բուֆերային գոտիները 
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9. Աշխատանք ռաստրային ֆայլերի հետ 

 

Սույն ուղեցույցում ռաստրային վերլուծությունը ներկա-

յացված է բարձրությունների թվային մոդելի (Digital Elevation 

Model, DEM) հիման վրա: 

 

9.1 Բարձրությունների թվային մոդել 

 

Ավելացնենք ArcMap-ում ՀՀ ԲԹՄ-ը և կարգավորենք դրա 

գունային սխեման (նկ. 108): 

 

 

Նկ. 108. ՀՀ տարածքի ԲԹՄ-ն 

 

Ռաստրային տվյալների Z արժեքները դիտելու համար 

անհրաժեշտ է Identify գործիքով քլիք անել հետաքրքրող 

հատվածի վրա: Identify պատուհանում կերևա ընտրված պիք-

սելի Z արժեքը (նկ. 109): 
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Նկ. 109. ԲԹՄ-ից բարձրությունների արժեքների դիտում 

 

9.2 Ռաստրային շերտից ընտրված տարածքի դուրս բերում 

(Extract by Mask) 

 

Ընդհանուր ԲԹՄ-ից առանձնացնենք Տավուշի մարզի 

ԲԹՄ-ը: Ավելացնենք ArcMap-ում մարզերի վեկտորային շեր-

տը և նշենք Տավուշի մարզը (նկ. 110): 

 

 

Նկ. 110. ՀՀ տարածքի ԲԹՄ-ն և մարզերի շերտը 
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Ռաստրային ֆայլից նշված հատվածը կտրելու համար 

անհրաժեշտ է օգտագործել Extract by Mask գործիքը՝ 

ArcToolbox => Spatial Analyst =>Extraction => Extract by Mask: 

Գործիքի պատուհանում Input raster դաշտում պետք է ավե-

լացնել ԲԹՄ-ն, Input raster or feature mask data-ում՝ մարզերի 

շերտը, Output raster-ում՝ ստեղծվող նոր ռաստրային ֆայլի 

(Տավուշի ԲԹՄ) պահման վայրն ու անունը (նկ. 111): 

 

 

Նկ. 111. ԲԹՄ-ի առանձնացում Տավուշի մարզի համար (Extract by Mask) 

 

OK կոճակը սեղմելուց հետո ծրագիրը կկառուցի 

ընտրված հատվածի ԲԹՄ-ն և կավելացնի ArcMap-ում (նկ. 

112): 

 

 

Նկ. 112. Տավուշի մարզի ԲԹՄ-ն 
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9.3 Ռելիեֆի պրոֆիլի կառուցում 

 

3D Analyst գործիքների միջոցով հնարավոր է կառուցել, 

օրինակ, գետի լայնակի կտրվածքի պրոֆիլը: Ավելացնենք 3D 

Analyst գործիքների պանելը (նկ. 113): 

 

 

Նկ. 113. 3D Analyst գործիքների պանելի ավելացում 

 

Վերցնենք Interpolate Line գործիքը և գծենք մեզ հետա-

քրքրող կտրվածքը՝ մկնիկի կոճակով սեղմելով սկզբնակետի և 

վերջնակետի վրա (նկ. 114): 
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Նկ. 114. Interpolate Line գործիքով գետի լայնակի պրոֆիլի գծում 

 

Դրանից հետո անհրաժեշտ է սեղմել Profile Graph կոճա-

կը: Կհայտնվի ընտրված կտրվածքի պրոֆիլը (նկ. 115): 

 

 

Նկ. 115. Պրոֆիլի գրաֆիկի կառուցում 
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Մկնիկի աջ կոճակով սեղմելով պրոֆիլի գրաֆիկի վրա, 

այնուհետև սեղմելով Export կոճակը՝ կարելի է պահել գրա-

ֆիկը նկարի տեսքով կամ արտահանել դրա տվյալները Excel 

ֆայլի տեսքով (նկ. 116): 
 

 

Նկ. 116. Պրոֆիլի գրաֆիկի արտահանում նկարի կամ Excel ֆայլի 

տեսքով 

 

9.4 Ռաստրային մակերևույթներ 
 

Բարձրությունների թվային մոդելից կարելի է ստանալ մի 

շարք ածանցյալ մոդելներ, օրինակ՝ բարձրությունների հորի-

զոնականներ, լանջերի թեքություններ, կողմնադրություններ, 

ստվերային ռելիեֆ և այլն: Այդ մոդելները ստանալու համար 

անհրաժեշտ է ArcToolbox-ից անցնել 3D Analyst => Raster 

Surface: 
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9.4.1 Հորիզոնականներ (Contour) 
 

Raster Surface գործիքների խմբից ընտրենք Contour 

գործիքը: Input raster դաշտում ընտրենք Տավուշի մարզի 

ԲԹՄ-ն, Output polyline features-ում՝ ելքային հորիզոնական-

ների ֆայլի (գծային վեկտորային շերտ) պահման վայրն ու 

անունը, Contour interval դաշտում՝ հորիզոնականների քայլը 

մետրերով (նկ. 117): 
 

 

Նկ. 117. Հորիզոնականների կառուցման Contour գործիքի պատուհանը 

 

Սեղմելով OK կոճակը՝ հորիզոնականների շերտը կավե-

լանա ArcMap-ում (նկ. 118): 
 

 
Նկ. 118. Տավուշի մարզի հորիզոնականների շերտը կառուցված Contour 

գործիքի միջոցով 
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9.4.2 Ստվերային ռելիեֆ (Hillshade) 

 

Hillshade ֆունկցիան հաշվարկում է մակերեսի լուսավո-

րությունը 0-255 արժեքներով տրված կողմնացույցի ուղղու-

թյան (ազիմուտ) և արևի բարձրության արժեքների հիման 

վրա: Hillshade շերտը նաև ավելի ռեալիստիկ է դարձնում 

ԲԹՄ-ի պատկերը: 

Raster Surface գործիքների խմբից ընտրենք Hillshade 

գործիքը: Input raster դաշտում ընտրենք Տավուշի մարզի 

ԲԹՄ-ն, Output raster-ում՝ ստեղծվող ստվերային ռելիեֆի 

ռաստրային ֆայլի պահման վայրն ու անունը: Մնացած 

արժեքները թողնենք ի լռելյայն (նկ. 119): 

 

 

Նկ. 119. Տավուշի մարզի ստվերային ռելիեֆի շերտի կառուցում Hillshade 

գործիքի միջոցով 

 

Ստացված ռաստրային ֆայլը տեղադրենք Տավուշի  

ԲԹՄ-ի վրա՝ մկնիկի աջ կոճակով սեղմելով Hillshade շերտի 

վրա, այնուհետև՝ Properties => Display: Transperency (թափան-

ցիկություն) պատուհանում մուտքագրենք 50 (%) արժեքը (նկ. 

120): 
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Նկ. 120. Տավուշի մարզի ստվերային ռելիեֆի շերտի թափանցիկացում 

 

Արդյունքում կստանանք ռելիեֆի ավելի ռեալիստիկ 

պատկեր, քան միայն ԲԹՄ-ն դիտելիս (նկ. 121): 

 

 

Նկ. 121. Տավուշի մարզի ստվերային ռելիեֆի շերտի և ԲԹՄ-ի 

համադրությունը 
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9.4.3 Լանջերի թեքություն (Slope) 

 

Raster Surface գործիքների խմբից ընտրենք Slope գործիքը: 

Input raster դաշտում ընտրենք Տավուշի մարզի ԲԹՄ-ն, Output 

raster-ում՝ ստեղծվող լանջերի թեքությունների ռաստրային 

ֆայլի պահման վայրն ու անունը: Output measurement դաշ-

տում թողնենք լանջերի թեքության DEGREE (աստիճան) չափ-

ման միավորը (նկ. 122): 

 

 

Նկ. 122. Տավուշի մարզի լանջերի թեքությունների ռաստրային շերտի 

կառուցում Slope գործիքով 

 

Ստացված ռաստրային շերտի յուրաքանչյուր բջիջ ներ-

կայացնում է լանջի թեքությունը բջջի տարածքում՝ ներկայաց-

ված աստիճաններով (նկ. 123): 
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Նկ. 123. Տավուշի մարզի լանջերի թեքությունների ռաստրային շերտը 

 

Արժեքները կարելի է դասակարգել ըստ միջակայքերի: 

Դրա համար անհրաժեշտ է մկնիկի աջ կոճակով սեղմել թե-

քության շերտի անվան վրա, այնուհետև՝ Properties => 

Symbology => Classified: Փոխենք դասերի քանակը (Classes)՝ 

դարձնելով դրանք 5 (նկ. 124): 

 

 

Նկ. 124. Լանջերի թեքությունների շերտի դասակարգումն ըստ 

միջակայքերի 
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Այնուհետև սեղմենք Classify կոճակը: Բացված պատու-

հանի Break Values հատվածում փոխենք արժեքները՝ 3, 6, 15, 

30, հինգերորդ արժեքը թողնենք նույնը՝ այն ներկայացնում է 

թեքության առավելագույն արժեքը (նկ. 125): 
 

 

Նկ. 125. Լանջերի թեքությունների միջակայքերի սահմանում 

 

OK կոճակը սեղմելուց հետո Symbology պատուհանի Label 

դաշտում փոխենք արժեքները՝ ինչպես ներկայացված է 

ստորև բերվող նկարում (նկ. 126): 
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Նկ. 125. Լանջերի թեքությունների միջակայքերի պիտակների 

փոփոխում 

 

Արդյունքում կունենանք հետևյալ պատկերը (նկ. 126): 

 

 
Նկ. 126. Լանջերի թեքությունների շերտը դասակարգված միջակայքերով 
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9.4.4 Լանջերի կողմնադրություն (Aspect) 

 

Raster Surface գործիքների խմբից ընտրենք Aspect գործի-

քը: Input raster դաշտում ընտրենք Տավուշի մարզի ԲԹՄ-ն, 

Output raster-ում՝ ստեղծվող լանջերի կողմնադրությունների 

ռաստրային ֆայլի պահման վայրն ու անունը (նկ. 127): 
 

 

Նկ. 127. Տավուշի մարզի լանջերի կողմնադրությունների ռաստրային 

շերտի կառուցում Aspect գործիքով 

 

Գործիքի կիրառման արդյունքում կստանանք լանջերի 

կողմնադրությունների ռաստրային շերտ, որտեղ յուրաքանչ-

յուր բջջի արժեք ցույց է տալիս հորիզոնի կողմերի նկատմամբ 

դրա ուղղվածությունը՝ ներկայացված աստիճաններով (նկ. 

128): 
 

 
Նկ. 128. Տավուշի մարզի լանջերի կողմնադրությունների ռաստրային 

շերտը 
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9.4.5 Տեսադաշտի վերլուծություն (Viewshed) 

 

Բարձրությունների թվային մոդելի հիման վրա կարելի է 

որոշել, թե նշված կետերից դիտելիս, որ տարածքներն են 

տեսանելի: 

Ստեղծենք նոր կետային վեկտորային շերտ, ավելացնենք 

ArcMap-ում: Միացնելով խմբագրման գործիքները՝ Տավուշի 

մարզի ԲԹՄ-ի որևէ մասում տեղադրենք կետ: Պահպանենք և 

ավարտենք խմբագրումը (նկ. 129): 

 

 

Նկ. 129. Տեսադաշտի վերլուծության համար կետային օբյեկտի 

ավելացում Տավուշի ԲԹՄ-ի վրա 

 

Գործարկենք տեսադաշտի վերլուծության գործիքը՝ 

ArcToolbox => 3D Analyst => Visibility => Viewshed: Input raster 

դաշտում ավելացնենք Տավուշի մարզի ԲԹՄ-ն, Input point or 
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polyline observer features-ում՝ նոր ստեղծված կետային շերտը 

(նկ. 130): 

 

 

Նկ. 130. Տեսադաշտի վերլուծության Viewshed գործիքի պատուհանը 

 

Գործիքի կիրառման արդյունքում կստանանք նոր 

ռաստրային ֆայլ, որտեղ գույներով առանձնացված կլինեն 

տվյալ կետից տեսանելի (Visible) և անտեսանելի (Not Visible) 

հատվածները (նկ. 131): 

 

 

Նկ. 131. Տեսադաշտի վերլուծության Viewshed գործիքի կիրառման 

արդյունքը 
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9.4.6 Վերադասակարգում (Reclassify) 

 

Ռաստրերի արժեքները հնարավոր է փոփոխել՝ օգտա-

գործելով Վերադասակարգում (Reclassify) գործիքը: Օրինակ՝ 

կարելի է վերադասակարգել լանջերի թեքությունների արժեք-

ները՝ թեքությունների միջակայքերը վերածելով ամբողջական 

թվերի: 

Գործարկենք Reclassify գործիքը՝ ArcToolbox => Spatial 

Analyst Tools => Reclass => Reclassify: Input Raster դաշտում 

մուտքագրենք Տավուշի մարզի լանջերի թեքությունների 

ռաստրային ֆայլը: Reclassification հատվածում ներկայացված 

են թեքությունների միջակայքերը և այն արժեքները, որոնք 

կտրվեն դրանց վերադասակարգումից հետո: Output raster 

դաշտում պետք է ընտրել ելքային ֆայլի պահման վայրն ու 

անունը (նկ. 132): 

 

 

Նկ. 132. Ռաստրերի վերադասակարգման գործիքի պատուհանը 

(Reclassify) 

 

Արդյունքում կստանանք նոր ռաստրային շերտ, որտեղ 

թեքությունների միջակայքերը դասակարգված կլինեն ամբող-

ջական թվերի տեսքով (նկ. 133): 
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Նկ. 133. Տավուշի մարզի լանջերի թեքությունների ռաստրային շերտի 

վերադասակարգման արդյունքը 

9.4.7 Ռաստրի փոխակերպում պոլիգոնի 

 

Նախորդ կետում վերադասակարգված թեքությունների 

ռաստրային շերտը կարող է փոխակերպվել պոլիգոնալ վեկ-

տորային շերտի՝ ըստ վերադասակարգված արժեքների: 

Ռաստրից պոլիգոն փոխակերպումն իրականացնելու հա-

մար անհրաժեշտ է գործարկել Raster to Polygon գործիքը՝ 

ArcToolbox => Conversion tools => From Raster => Raster to 

Polygon: Input raster դաշտում պետք է ընտրել լանջերի թեքու-

թյունների վերադասակարգված ռաստրային շերտը, Output 

polygon features-ում՝ ստեղծվող պոլիգոնալ շերտի պահման 

վայրն ու անունը (նկ. 134): 
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Նկ. 134. Ռաստրից պոլիգոն փոխակերպան գործիքի պատուհանը 

(Raster to Polygon) 

 

 
 

Նկ. 134. Տավուշի մարզի լանջերի թեքությունների ռաստրից պոլիգոն 

փոխակերպան արդյունքը 

 

Արդյունքում կստանանք պոլիգոնալ շերտ, որի ատրիբու-

տային աղյուսակում կլինեն վերադասակարգված ռաստրային 

շերտի արժեքները (նկ. 135): 
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РЕЗЮМЕ 
 

Программа ArcGIS 10: 

Учебно-методическое пособие 
 

Аракелян Александр, Артак Пилоян 

 

Это руководство представляет собой описание географи-

ческой информационной системы (ГИС) – инновационной техно-

логии, которая изменила способы взаимодействия с простран-

ственными данными и их анализ. Карты были важным инстру-

ментом для человеческого общества на протяжении тысячелетий, 

но около сорока лет назад начала развиваться ГИС, что ознаме-

новало значительный сдвиг в способах использования географи-

ческой информации. Основным принципом ГИС является инте-

грация графических (пространственных) и описательных (атри-

бутивных) данных, позволяющая получить более полное и много-

мерное представление о географических явлениях. Эта интегра-

ция позволяет пользователям визуализировать, анализировать и 

интерпретировать данные для понимания взаимосвязей, законо-

мерностей и тенденций, что делает ее важнейшим инструментом 

в самых разных областях – от экологических исследований до 

городского планирования и управления ресурсами. 

Руководство предназначено для того, чтобы предоставить 

пользователям практический обзор ArcGIS 10, одного из наи-

более широко используемых пакетов программного обеспечения 

для ГИС, разработанного компанией ESRI. Руководство состав-

лено таким образом, чтобы помочь как студентам, которые участ-

вуют в учебных занятиях по ГИС, так и тем, кто учится самостоя-

тельно. Краткое описание ключевых функций ГИС, рассмо-

тренных в практических упражнениях, позволяет пользователям 

понять основные операции и концепции ГИС. Независимо от 

того, связана ли задача с картографированием, визуализацией 

данных, пространственным анализом или созданием подробных 

географических отчетов, руководство служит ценным ресурсом 

для всех, кто стремится использовать возможности ГИС в своей 

работе или учебе. 
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ArcGIS – это обширный набор программного обеспечения 

ГИС, поддерживающий различные платформы, включая настоль-

ные компьютеры, серверы, мобильные устройства и онлайн-

приложения. В рамках этого набора ArcGIS Desktop представляет 

собой комплексный программный пакет с надежной функцио-

нальностью, особенно на уровне ArcInfo, который предоставляет 

расширенные инструменты и возможности. В руководстве особое 

внимание уделяется настольной версии ArcGIS, а также описы-

ваются ее мощные расширения Spatial Analyst и 3D Analyst. 

Spatial Analyst предоставляет пользователям инструменты для 

комплексного анализа растровых данных, такого как анализ 

пригодности и моделирование поверхности, в то время как 3D 

Analyst позволяет осуществлять трехмерную визуализацию и мо-

делирование данных, что необходимо для таких приложений, как 

анализ рельефа и инфраструктуры. Эти инструменты имеют нео-

ценимое значение для тех, кто занимается экологическими иссле-

дованиями, городским планированием, геологией и другими об-

ластями, требующими детальной пространственной перспективы. 

В дополнение к объяснениям того, как работать с програм-

мным обеспечением, данное руководство направлено на улуч-

шение навыков решения проблем пользователей в ГИС. В нем 

рассматриваются различные сценарии и приложения, а также 

приводятся практические примеры использования инструментов 

ГИС для решения реальных задач. Например, пользователи могут 

научиться использовать пространственный анализ для принятия 

решений на основе данных в таких областях, как борьба со сти-

хийными бедствиями, где ГИС может моделировать маршруты 

эвакуации или оценивать районы, подверженные риску. Руко-

водство призывает пользователей творчески подходить к приме-

нению функций ГИС, подчеркивая, что ГИС – это не просто 

картографический инструмент, а мощная система поддержки 

принятия решений, способная выявить информацию, которая в 

противном случае могла бы остаться незамеченной. 

Это руководство представляет собой нечто большее, чем 

простое руководство по эксплуатации, это инструмент, пред-

назначенный для содействия самостоятельному обучению и 

исследованию в области ГИС. Независимо от того, является ли 

читатель новичком или имеет некоторый опыт работы с ГИС, 
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цель данного руководства – расширить его возможности по при-

менению концепций ГИС в практическом контексте. Благодаря 

понятным объяснениям и примерам руководство позволяет поль-

зователям углубить свое понимание анализа пространственных 

данных и дает им навыки, необходимые для решения сложных 

геопространственных задач с использованием ArcGIS. 
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SUMMARY 

 
User Guide for ArcGIS 10 

 
Aleksandr Arakelyan, Artak Piloyan 

 

This guidebook offers an introduction to Geographic 

Information Systems (GIS), an innovative technology that has 

transformed how we interact with and analyze spatial data. While 

maps have been an essential tool for human societies for thousands 

of years, GIS only began developing around 40 years ago, marking a 

significant shift in how geographical information is utilized. The 

core principle of GIS is the integration of graphical (spatial) and 

descriptive (attribute) data, allowing for a more comprehensive and 

multi-dimensional understanding of geographical phenomena. This 

integration enables users to visualize, analyze, and interpret data to 

understand relationships, patterns, and trends, making it a critical 

tool in fields ranging from environmental studies to urban planning 

and resource management. 

Guidebook is aimed at providing users with a practical 

overview of ArcGIS 10, one of the most widely used GIS software 

packages, developed by the Environmental Systems Research 

Institute (ESRI). The guide is structured to support both students 

who have participated in GIS training sessions and those who are 

learning independently. By summarizing the key GIS functions 

observed in practical exercises, it allows users to grasp essential GIS 

operations and concepts. Whether the task involves mapping, data 

visualization, spatial analysis, or creating detailed geographic 

reports, the guide serves as a valuable resource for anyone aiming 

to leverage the power of GIS in their work or studies. 

ArcGIS is an extensive suite of GIS software that supports 

various platforms, including desktop computers, servers, mobile 

devices, and online applications. Within this suite, ArcGIS Desktop 
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is a comprehensive software package with robust functionality, 

especially through the ArcInfo level, which provides advanced 

tools and capabilities. The guide specifically focuses on the ArcGIS 

Desktop version and also covers its powerful Spatial Analyst and 3D 

Analyst extensions. Spatial Analyst equips users with tools for 

complex raster data analysis, such as suitability analysis and surface 

modeling, while 3D Analyst allows for three-dimensional data 

visualization and modeling, essential for applications like terrain 

and infrastructure analysis. These tools are invaluable for those 

involved in environmental research, urban planning, geology, and 

other fields that require a detailed spatial perspective. 

In addition to explaining how to operate the software, this 

guide aims to enhance users' problem-solving skills in GIS. By 

walking through various scenarios and applications, it provides 

practical examples of how to use GIS tools to address real-world 

challenges. For instance, users can learn how to employ spatial 

analysis to make data-driven decisions in fields like disaster 

management, where GIS can model evacuation routes or assess 

areas at risk. The guide encourages users to apply GIS functions 

creatively, emphasizing that GIS is not just a mapping tool but a 

powerful decision-support system capable of revealing insights that 

might otherwise be overlooked. 

This guidebook is more than a simple instruction manual, it’s a 

tool designed to foster independent learning and exploration within 

the GIS field. Whether the reader is a beginner or has some 

experience with GIS, this guide aims to enhance their ability to 

apply GIS concepts in a practical context. Through clear 

explanations and examples, the guide enables users to deepen their 

understanding of spatial data analysis and equips them with the 

skills necessary to tackle complex geospatial challenges using 

ArcGIS. 
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